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Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

Danger

indicates that death or severe personal injury will result if proper precautions are not taken.

Warning

indicates that death or severe personal injury may result if proper precautions are not taken.

Caution

> BB

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

Caution

without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

Notice

indicates that an unintended result or situation can occur if the corresponding information is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes
in this documentation qualified persons are defined as persons who are authorized to commission, ground and
label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage
Note the following:

A Warning
This device may only be used for the applications described in the catalog or the technical description and only in
connection with devices or components from other manufacturers which have been approved or recommended
by Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and
assembly as well as careful operation and maintenance.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent

editions.
Siemens AG Order No.: ASE00480391-01 Copyright © Siemens AG .
Automation and Drives Edition 12/2005 Technical data subject to change
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Introduction 1

1.1 Introduction

Introduction

This Getting Started contains a practical example guiding you through thirteen steps in
commissioning a fully functional application, and showing you how to carry out motion
commands. It is thus a valuable help in getting started with the basic functions of a CPU
317T-2 DP.

Depending on your degree of experience, working through the sample will take between two
and three hours.

Note

This Getting Started presumes that you have connected a SINAMICSSINAMICS 5120 drive to
the DP (DRIVE) interface of the CPU 317T-2 DP In case you do not have a drive, we
recommend you refer to the Getting started documentation "CPU 317T-2 DP: Controlling a
virtual axis".

CPU 317T-2 DP: Controlling a SINAMICS S120
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Preparation

2.1 Requirements

Requirements

The following requirements must be fulfilled:

e An S7-300 station, consisting of:

Power supply module (PS), for example, 6ES7 307-1EA00-0AAQ
CPU 317T-2 DP with inserted MMC (4 MB or more).

Optional digital input module (DI) with bus connector, for example,
6ES7 321-1BH02-0AA0

Optional digital output module (DO) with bus connector, for example,
6ES7 322-1BH01-0AA0

Two optional front connectors for the digital modules

o A PG with MPI interface and properly installed software packages and commissioning
tools as listed below:

STEP 7 V5.3 SP3 and higher
S7-Technology V3.0

e The PG is connected to the CPU via the MPI/DP interface (transmission rate up to 12
Mbps; default 187.5 kbps).

e A SINAMICS® S120 is connected to the CPU 317T-2 DP via the DP (DRIVE) interface.
e The SINAMICS® S120 comprises the following modules:

CU320 control unit with TB30 terminal board (6SL3040-0MAO00-0AA1)
Smart line module, 5 kW (6SL3130-6AE15-0AA0-2Z)
Single/double motor module, 3 A (6SL3120-2TE13-0AA0-2)

1 synchronous motor 1FK7022-5AK71-1AG3 with incremental encoder sin/cos 1 Vpp

via SMC20 sensor module cabinet (6SL3055-0AA00-5BA1)

1 synchronous motor 1FK7022-5AK71-1LG3 with DRIVE-CLIiQ interface: Absolute
encoder EnDat 512 pulses/revolution

Reference loops for position monitoring

Control box for setpoint/actual-value linkage via terminals

¢ You know the firmware version of your SINAMICS S120.

CPU 317T-2 DP: Controlling a SINAMICS S120
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Preparation

2.1 Requirements

VAN

2-2

If you do not know the firmware version, then you can find the version on the supplied
certificate. Alternatively, you can open the "content.txt" file on the CF card. The firmware
version is in the "Internal Version" entry. You can find more detailed information on
reading the firmware version in the SINAMICS S120 product information.

Note

For the example of a drive in Getting Started, we use a SINAMICS® S120 training case.
The training case is available under the following order number:

e Axis version with 1FK7 motor
6ZB2480-0AA00

¢ Axis version with 1FK7 motors
6ZB2480-0BA00

The system is completely installed and wired. For information, refer to Geffing Starfed
CPU 31x: Commissioning.

You provided hardware limit switches and EMERGENCY-OFF switches for safe and
reliable operation of the system.

Warning

Operation of an S7-300 as part of plants or systems is subject to special rules and
regulations, based on its field of application. Please note the current safety regulations for
the prevention of accidents, e.g. IEC 204 (EMERGENCY-OFF equipment). You risk
severe injury, or damage to machines and equipment if you ignore these directives.

CPU 317T-2 DP: Controlling a SINAMICS S120
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Preparation
2.1 Requirements

Example configuration

MMC
Mode selector
LEDS / Integrated inputs/outputs for technology
\
Setting of supply voltage i/ N7
= DRIVE-CLIQ
Power supply ON/OFF 0 ! “
pply \;_a |
Mounting rail \b bs cPU |
5T 50 No DRIVE-
PROFIBUS cable for intorface
— connection to the MPI PROFIBUS
interface DP (DRIVE)
___ \
Programming CU 320
device (PG) with
-STEP7
- S7-Technology
Smart Line |Double Motor|
Module Module Module
Motor
&
Enco-
der 1
Task

Configuration of an axis using HW Config and S7T Config. You then operate this axis with
the help of a STEP 7 user program.
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Learning units 3

3.1 1. Step: Wiring

A Warning
You may come into contact with live wires. Always switch off power before you start wiring
the S7-300.

Procedure

A description of the installation and wiring of your 317T-2DP CPU is found in the Gefting
Started Collection S7-300 PLC: CPU 31x: Commissioning.

Set the PROFIBUS address of the SINAMICS® to PROFIBUS address 4. The setting of the
PROFIBUS address on the CU230 directly via the hardware DIP switch, is performed in the
following way:

Control Unit

Figure 3-1 Schematic representation of the CU320 control unit

PROFIBUS interface
PROFIBUS diagnostics LED "DP1"
PROFIBUS address switch

® 0O 06

CPU 317T-2 DP: Controlling a SINAMICS S120
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Learning units

3.2 2. Step. Configuring CPU 317T-2 DP with HW Config

L’“’"

PROFIBUS _— |

interface

DP ADDRESS ﬂﬁ"

(LTS

20 21 22 23 28 5 6

D+D+4+0+0+0+0=4

3.2 2. Step: Configuring CPU 317T-2 DP with HW Config

Procedure
Sequence Activity Result
1 Create a new project in the SIMATIC Manager (for example, The SIMATIC 300 station appears
"GS_317T2-DP_with_S120") and add a SIMATIC 300 station. in the SIMATIC Manager.
2 Open HW Config by selecting the "SIMATIC 300" station and double- | HW Config opens.
clicking "Hardware".
CPU 317T-2 DP: Controlling a SINAMICS S120
3-2
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Learning units

3.2 2. Step. Configuring CPU 317T-2 DP with HW Config

Sequence Activity | Result
3 Open the "Hardware Catalog" and select the "SIMATIC Technology CPU" hardware profile in the "Profile"
drop-down list.
[ Hw Config - [SIMATIC 300(1} {Configuration) - GS_317T2-DP_with_S =10l x|
Eﬂ] Station Edit Insert PLC Miew Options ‘Window Help 12| =|
D|e-® %) & Bl dnlsal B2 22 »|
=1
Eind: | at| il
Prafile; ISIM.-’-‘«TIE Technologp-CFLU j
ED SIMATIC Technalogy =
HE] SIMATIC 300
--{:l CP-300
--{:l CP1-300
--{:l Frd-300
l:l 5 ateway
EH:l PS-300
o d Ps 207108
o q Ps 30728
‘ | | , P 4 Ps 3078
= EH:l RACK-300
L= Rail |-
&= o U (1 5M-300
+-zg= PROFIBLIS DP
Slot b odule | 0. | Fi.. | o.|C E Jﬂa—&l T, LI
1 PS5 307 B4 BESY BESY 307-1EAND-O&a0 £<|
2 _ | |Load zupply voltage 120 / 230°AC: 24 WDC /5 ——
3 £l
Insertion possible | Chg
Result: The "SIMATIC Technology" directory is displayed.
4 Insert a mounting rail using drag-and-drop in the station window of This creates a mounting rail.
HW Config.
5 Drag-and-drop the "PS 307 5A" power supply module onto the The power supply module appears
mounting rail. on the mounting rail.
6 Add the Technology CPU to the mounting rail by means of drag-and- | A message box appears.
drop.
7 You change the transmission rate in the next step. In the next dialog box, you can set
Confirm the message box with "OK_.“ the PROFIBUS properties of the DP
8 Confirm the default settings of the PROFIBUS configuration with
IIOKII.

CPU 317T-2 DP: Controlling a SINAMICS S120
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Learning units

3.3 3. Step: Changing the transmission rate at the MPI/DP interface

Sequence Activity Result
9 Add a digital input module and a digital output module.
You now have this layout:
E@Hw Config - [SIMATIC 300(1) {(Configuration) -- G5_317T2-DP_with - |EI|5|
Eﬂ] Stakion Edit Insert PLC  Wiew Options ‘Window Help =] x|
D[(3-® (% S Ble dldl =] 28w
1= Sl
1 IEEE - PROFIBUS() DF || =70 ! _f|_1-|ﬂ= i
Profile: ISIM.-’-\TIC Technolagy-CPU j
=1 SIMATIC Technology 4]
=-Fl SIMATIC 300
-3 CP-300
-] CPU-300
5 -0 FM-300
B o -1 Gateway
7 -3 PS-300
8 - B0 RACK-300
2 =-{Z3 5M-300
B A1-300 —
-0 A1AA0-300
- A0-300
=+ DI-300
ud =-1 DID0-300
LI—I _'I—I E-]D 0a-300
SM 322 DOTERACT20M A0 A
ﬂ:l [0 UR SM 322 DOTExACT20M A0 BA
SM 322 DOTERACT20M 23014
E Order number . | Fio | M| I | G| .. | 3. | Com. I St 322 DOTERDC24 A0 50,
SM 322 DOTERDC24 0,54
SM 322 DO1E:DC24V 0.5
1]
BEST 322-1BHO1-04A0 H
Digital output module DO16 24%/0.54, grouping 8; also =
available az SIPLUS module with arder number BAG1
322-1BHO1-2840
Press F1 to get Help. [ [ 2
3.3 3. Step: Changing the transmission rate at the MPI/DP interface
Procedure
Sequence Activity Result
1 Open the MPI/DP interface (X1) in HW Config with double- | The "Properties - MPI/DP" dialog box opens.
click.
2 Click "Properties". The "Properties — MPI interface MPI/DP"
dialog box opens.
3 Click MPI(1), then click "Properties". The "Properties - MPI" dialog box opens.
CPU 317T-2 DP: Controlling a SINAMICS S120
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Learning units
3.4 4. Step: Vital settings in your DP (DRIVE) configuration

Sequence Activity Result
4 Select the "Network settings" tab and select a transmission
speed of "1.5 Mbps".

5 Confirm all open dialog boxes with "OK". You have now increased the configured
transmission speed of the MPI interface at
the CPU in order to accelerate data transfer.

6 When the CPU is in STOP, select PLC > Download to The "Select node address" dialog box
download the configuration. Select the CPU and confirm opens.
with "OK".

The default transmission rate of the MPI
interface is 187 kbps, i.e. the PG/PC
interfaces must be set up as described
earlier in the requirements section.

7 Confirm with "OK". The data are now downloaded from the
PG/PC to the CPU.

3.4 4. Step: Vital settings in your DP (DRIVE) configuration

Procedure
Sequence Activity Result
1 In HW Config, double-click X3 DP (DRIVE). The "Properties — DP (DRIVE)" dialog box
opens.
2 Click the "Properties" button. The "Properties - PROFIBUS interface DP
(DRIVE)" dialog box opens.
3 Enter PROFIBUS address "2".
4 Click "New" to create a new PROFIBUS subnet. The "Properties — New subnet PROFIBUS"
dialog box opens.
5 In the "Network settings" tab of the next dialog box, set the
transmission rate of the PROFIBUS network. Enter a rate of
12 Mbps.
Maintain the "DP" profile setting of the subnet.
6 Click "OK" to confirm all open dialog boxes of HW Config.

CPU 317T-2 DP: Controlling a SINAMICS S120
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Learning units

3.5 5. Step: Generating technology system data

3.5 5. Step: Generating technology system data

Procedure

Sequence Activity Result

1 Double-click "Technology" on the mounting rail. The "Properties - Technology" dialog box
opens.

2

Confirm with "OK".

General Technaology system data I Technology version I

¥ Generate technology system data

Properties - Technology - (RD/53) El

Select the "Technology system data" tab, then set the "Generate technology system data" check box.

Cancel Help

Result: When you download these data to the PLC later on in this Getting Started, the system also
generates the technology system data and includes these in the download to your CPU 317T-2 DP.

Note: If you do not activate the check box, then the technology system data is also not generated.

3-6
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Learning units
3.6 6. Step. Configuring the drive in HW Config

3.6 6. Step: Configuring the drive in HW Config

Procedure
Sequence Activity Result
1 In the HW catalog, open the tree structure
SIMATIC Technology > PROFIBUS DP (DRIVE) > Drives >
SINAMICS.
2 Select the drive component "SINAMICS S120" from the tree structure of the HW catalog.
[ HW Config - [SIMATIC 300{1) (Configuration) - GS_317T2-DP_with_5 =10 =|
Em Skation Edit Insert PLC  Wiew Options ‘Window Help == =]
02|32 (% S| =2 dboldl [@E] 328
= [0] LR : 8l
1 FS 307 54 = End | nﬂ nﬂ
2 CPU 317T-2 DP
g MEVDE Profile: | SIMATIC Technolagy-CPU =]
- Toopeney = SIMATIC Technology
ADHIVE) ] PROFIBUSH| - SIMATIC 300
XTT S Tachnoiogy) :
4 DI1EsDC24Y -3 PROFIBUS DP
5 DOTED T2 /0 B, EH:I PHDF'.BUS DPIDRIVE)
5 1| L—"_Ii:l Dirives
- |:| MaSTERDRIMES CBPZ
2 -0 MICROMASTER 4
= ~| -] SIMODRIVE
=0 SINAMICS
q | : TR M AMICS 512
= -0 ET 200M
-] ET 2003
:l:l SIMATIC 300(1] {21 Additional Field Devices
[+ Microbos T
Slutl Deszignation £ Microbox
ESLI040-0-500- D [S57:20] f(l
SINAMICS 5120 DF Slave. Drive ES / -
ROADP master system (1] SIMOTION Interface, Cyclical and Acyclical
Communication, lsochronous Mode
Press F1 ko get Help. | Cha
3 Drag-and-drop this component to the master system of the | The "Properties — PROFIBUS interface
DP (DRIVE). SINAMICS" dialog box opens.
4 Enter PROFIBUS address "4", then confirm with "OK". The "Properties - SIMOTION Drive" dialog
box opens.

CPU 317T-2 DP: Controlling a SINAMICS S120
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Learning units

3.6 6. Step. Configuring the drive in HW Config

Sequence Activity | Result
5 Select the appropriate drive version for your SINAMICS® and confirm with "OK".

Properties - SIMOTION drive El

General  Drive Unit / Buz Address |

Device type: | SINAMICS 5120 |

Device version R ~ |
Bus addr.: |4 j

Cancel Help

6 The "DP Slave Properties" dialog box opens. Select the The "Clock Synchronization" dialog box
"Clock Synchronization" tab. opens.

CPU 317T-2 DP: Controlling a SINAMICS S120
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Learning units

3.6 6. Step. Configuring the drive in HW Config

Sequence Activity | Result
7 Set the "Synchronize drive with equidistant DP cycle", then set the time coefficients as shown below.

DP Slave Properties x|

Generall Configuration  Clack Synchranization |

¥ Sunchronize diive with equidistant DF cycle

— Metwork Settings [mz]

|E|:|ui|:|istant busg cycle not activated

E quidiztant DPF cycle: ID-E":":' [rata_Ewxchange Time Tdx IEI.1 41

- Factor Time frame/timebaze [mz]
osespledlon [ L [T 3], [rom
Factor Time frame/timebaze [mz]
DP cycle Tdp [ms]: |1.unn = |a j " |u.125
Factor Time frametimebasze [ms]
Time Ti[mz] = Ii
[&ctual value acouizition]; ID'125 = I1 = b iz
Time To [rm] Factor Time frametimebase [mz]
[Setpoint fransfer]; IDB?5 = IE ﬁ b ID-125

Alignrment |

Cancel | Help

8 Click "Alignment". The following components are aligned to the
set values:

e DP cycle in the DP master system

e All drive components of the same family
(here SINAMICS®) are aligned to the set

values.
9 Confirm with "OK".
10 Confirm the possible warning with "OK".
11 Finalize your HW configuration by calling the Station > Save | The system compiles your project, and adds
and compile command. the "Technology Objects" object to the

project window in SIMATIC Manager.

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.7 7. Step: Configuration of the PG/PC inferface

3.7 7. Step: Configuration of the PG/PC interface
Procedure
Sequence Activity Result
1 Start the NetPro network configuration program in HW NetPro is started
Config with Options > Configure network.
2 In the HW catalog, open the tree structure
Stations > PG/PC and drag-and-drop a PG/PC station into the "Network View" window.
ﬁ%NetPro - [GS_317T2-DP_with_S120 {Network) -- C:\Program Files'...\s 7proj",GS_317T2 1Ol x|
%@ Metwork  Edit  Insert PLC Wiew OCptions  Window Help &=l
=9 || S| B=|e| dld| 8| 8| [BEl L] e
WA 1 1= ol x|
AP Find: I ﬁ:l: ﬂr!l
PROHBUSH Selection of the network
FROFIEUS PROFIBUS DF
T T L9 Lo OnBUS-PY
- PROFINET IO
- D Stations
|S|MAT|C 300(” - DtherStatlon
\'_ || :?1':#2 WPIDP I'Lechno ESDRI
oe o @ SMATIC 300
:l ‘m — E SIMATIC 400
B, 5IMATIC PC Station
@ SIMATIC 55
[l SIMATIC 57-400-H
- {:I Subnets
E3
= Frograriming Device or PC A
4 | »
Ready CPEE1L(MPI) [% 506 7
CPU 317T-2 DP: Controlling a SINAMICS S120
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Learning units

3.7 7. Step: Configuration of the PG/PC interface

Sequence Activity | Result

3

Select the newly inserted PG/PC component and open the "Properties — PG/PC" dialog box with Edit >

Object properties. ...
E‘.!__%NetPru - [GS_317T2-DP_with_%5120 {Network) -- C:\Program Files'...\s7projiGS_31712] -0 x|
%@Network Edit  Insert PLC  Wiew Options ‘Window Help 18| x|
=8 |9 & e daldl 8] g2 B e
MPI1) - olx
M| Find: I ﬁﬂ: ﬁil
PROHBUS('] Selection of the netbwork,
FROFIEUS

ﬂ! FROFIEUS DF

1

|SIMATIC 300(1)

T CRU MPI/OP [Techna | OF(DRI
= 37T gy WED
oE :
| |

|2 2
| SINAMICS
5120

4

< |

—'ﬁ'ﬁ! FPROFIBUS-PA

—'ﬁ'ﬁ! FROFIMET 1D

B Stations

i B Dther Station
) PG/PE

SIMATIC 300

-l SIMATIC 400

B, SIMATIC PC. Station
: -E=]) SIMATIC 55

F-C0 Subnets

_’ILI Frograriming Device ar PC

Ready CPEE1L(MPT) [ 554 7

%

CPU 317T-2 DP: Controlling a SINAMICS S120
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Learning units
3.7 7. Step: Configuration of the PG/PC inferface

Sequence Activity Result
4 Select the "Interfaces" tab in the "Properties — PG/PC" dialog box.
Click the "New..." button to open the "New Interface — Type Selection" dialog box. Select "MPI" and confirm
with "OK".
x|
General Interffaces | Lzzignmment I
Mame | Type | Address | Subnet |
x|
Type: Industrial Ethernet
FPROFIELS
MHew. .. | [Delete
k. I Cancel Help
k. | Cancel Help
Result: The "Properties - MPI Interface" dialog box opens.
CPU 317T-2 DP: Controlling a SINAMICS S120
3-12
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Learning units
3.7 7. Step: Configuration of the PG/PC interface

Sequence Activity | Result
5 In the "Properties - MPI Interface" dialog box, select address "1" and the "MPI network". Confirm your input
with "OK".

Properties - MPI interface El

General  Parameters |

Addreszs: |1 - I

Highest addrezs: 31

Tranzmigzion rate; 12 Mbps

Subnet:

--- fiot niebworked --

MHew... |

Froperties... |

Delete |

Cancel Help

CPU 317T-2 DP: Controlling a SINAMICS S120
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Learning units

3.7 7. Step: Configuration of the PG/PC inferface

Sequence Activity | Result
6 Select the "Assignment" tab in the "Properties — PG/PC" dialog box.
Assign the MPI interface parameterization in the PG/PC to the configured interface by clicking "Assign".
x
General I Interfaces  Assignment |
— Mot Azzighed
Configured Interfaces:
M arme Tupe Subnet 1
kPl interface(1] MPIT]
Interface Parameter Azzignments in the PGAPC:
CFRE1T[FP
CP5E11[PROFIEBUS - DF Slave)
CP5E11[PROFIBUS) ;l | Azgign I
Azzigned: [Mzconnesct |
Interface | Parameter aszign... | Subnet | 570nline .
SYOMLIME Access:
1| | Mo setive
k. | Caricel | Help
CPU 317T-2 DP: Controlling a SINAMICS S120
3-14 Getting Started, 12/2005, ASE00480391-01



Learning units

3.7 7. Step: Configuration of the PG/PC interface

Sequence Activity

| Result

7 Complete the configuration by clicking "OK".

General I Interfaces .ﬁ.ssignmentl

Properties -PG,/PC x|

— Mat Azzigned
Configured Interfaces:

I ame | Type

| Subnet

CPSET1[FROFIBUS - DF Slave)
CPSE11(FROFIEUS)
IS0 Ind. Ethemnet - Inte[R] PROA00 ...

b o B UL e TP B T e BN L T R E B n T L W I

|nterface Parameter Azzignments in the PGAPC:

Szzian I

=l |

Azzigned: [Nizconnest |
Interface | Parameter agzigr... | Subnet | S¥0nline .
MPl interface(1) CPSE11[MPI) MPI1] Active
SYOMLIME Access:
1] | Mo ctive
ak. | Cancel | Help

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.7 7. Step: Configuration of the PG/PC inferface

Sequence

Activity

Result

8

with the SINAMICS® contro

ZENetPro - [G5_317T2-DP_with_5120 {Network) -- C:\Program Files',

You have now inserted your PG/PC in the MPI network and established the condition to exchange data

S TprojiGs_317T2]

| 2

p— SINAMICS
l" /5120

2

4

|

_|o x|
%@ Metwork  Edit  Insert PLC Wiew OCptions  Window Help &=l
=¥ |9 S| e &bl 2] o2 [Bal e
WP T = oix|
AP Find: I ﬁ:l: ﬂr!l
PROHBUSH Selection of the netwark:
FROFIEUS PROFIBUS DF
T T L9 Lo OnBUS-PY
- PROFINET IO
- D Stations
|CSP|E\4AM—|;!.EP3TO?(1 :IDP(DRI 5 e Station
2 :G nOI B3 PG/PC
|| 3|:|1P?T2 e :VEJ [} SIMATIC 300
] ‘B 1

= f<|
_’I—I Frograriming Device or PC =

SIMATIC 400

B SIMATIC PC Statian
- satic 5
SIMATIC 57-400-H
- {:I Subnets

Ready

CPEE11MPTY [ 356 4

Compile

x|

" Compile changes only

¥ Compile and check eventhing

ok ]

Cancel

Help

Complete the network configuration by calling the Network > Save and compile command.
Select "Compile and check everything" and confirm with "OK".

Save and Compile
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3.7 7. Step: Configuration of the PG/PC interface

Sequence Activity | Result
10 Close the output window with File > Close.
4% Dutputs for consistency check for C:\Program Files:Sie - |EI|£|
File Edit
Messag... | Message | Project. .. | Project path
Mo errors,
4| | b
11

Close the NetPro configuration program by calling the Network > Exit command.
E‘.!__%NetPru - [G5_317T2-DP_with_5120 {Network) -- C:'Program Files'..., s7projiGS_317T2]

=10l x|
EE-H Metwork, Edit Insert PLC Wiew  Opbions  Window  Help 18| x|
Opern, .. Chrl+O
—  Close
ol x|
Save ) -
Save and Compile... Chrl+5 Find: I i || “i-l'
Check Consistency Chrl+Al+HE Selection of the network,
Check Cross-Project Consistency, el Al
[]--ﬁ! FROFIBUS DP
Print... Chrl+P .22 PROFIBLS Pa

Print Preview. ..
Page Setup...

=4 PROFINET IO
=3 Stations

1 G5_317T2-DP_mit_S120 {Metz) -- C:\Program FilesiSiemens|Step?s?projias_317T2

i B Other Station
PG/PC

| 2 2

a |

il

Closes all windaws in this application and exits the application.

CPSELL(MPI) % 31 2

SIMATIC 300

[ SIMATIC 400

B, SIMATIC PC Station
2D SIMATIC 55
SIMATIC 57-400-H
F-2] Subnets

Frogramming Device or PC

%

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.8 8. Step: Downloading the hardware configuration to the target hardware

3.8 8. Step: Downloading the hardware configuration to the target
hardware
Procedure
Sequence Activity Result
1 Switch back to HW Config
Download the hardware configuration to the CPU by calling the PLC > Download ... command.
@E_:HW Config - [SIMATIC 300{1} {Configuration) - G5_317TZ2-DP_with_S -0 x|
Eﬂ] Skabion Edit Insert | PLC  Yiew Opkions  Window  Help - =] x|
~ C Jownload. .. Chrl+L
0= 2., 0 Do
| |m | |g?u| -é' Upload. ..
=1
im_ Downlaad Madule Tdentification, .. _I__I
PS 307 54 Upload Module Identification ta P&, . I i Il “fl-
4 CPU 317T-2 DF
o MEFDE Faulty Modules. ., ISIMATIE Technology-CPU j
; ;ﬁgfgf Madule Infarmation. .. Ctri+D  FIMATIC Technology
Lo Oy Tach y operating Mode. .. Chr|+T SIMATIC 300
o E:-:DEJECF'J Y ClearjReset.., FROFIBUS DP
DOTGADC24v/05 oo M= cfDEy. Hl PROFIBUS DPIDRIVE]
Monitar/Madify :-H:' Drrives
{:I MASTERDRIVES CBP2
Update Fitmware, .. |:| MICROMASTER 4
Save Device Mame ta Memory Sard, .. g g:mg::l?:l:l;
Ethernet 3 - B SINAMICS 5120
4
N F— 03 ET 200M
PROFIEUS 3
A-(_] ET 2005
:l:l (4] SIMAMICS, Save Service Data, . ]l:| Additional Field Devices
| Microbox T
Slat Module .| | addrezss | O addiess Comrmen ||
E) Lot D33 SHE AT E5L3040-0:800-0x [5120] £
5 e i = |5INAMICS 5120 DF Slave. Drive ES / -
: TR SIMOTION Interface, Cyclical and Acyolical
Communication, |sochronous bode
Loads the current skation into the load memaory of the current module, | v

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.8 8. Step. Downloading the hardware configuration to the target hardware
Sequence Activity | Result
2 Select the "CPU317T-2DP" and confirm with "OK".
x|
Target modules:
Module | Racks St
CPUA17T-2 DP 2

Select Al |

Cancel Help

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.8 8. Step: Downloading the hardware configuration to the target hardware

Sequence Activity | Result
3 Enter the MPI address of your destination address and confirm with "OK".

Select Node Address x|

Ower which station addrezz iz the pragramming device connected to the module CP 317T-2
DF?

Rack: IEI _l:
Slat: Iﬂ

T arget Station: * Local

) Can be reached byimeans of gateway

Enter connection to target station:
MPI address | Module tvpe | Skation name | CPUI name | Plant designation

(A | cPU317T... SIMATICS... CPU3L...

Aocezsible Modes

Wi

Cancel Help

Result: The data are now downloaded from the PG to the CPU.
4 Also close the HW Config by calling the Station > Exit command.

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.9

Procedure

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

9. Step: Configuration of the SINAMICS drive with S7T Config

Sequence

Activity

Result

1

In SIMATIC Manager, double-click "Technological Objects® to open S7T Config.

QSIMATIE Manager - [GS_317TZ2-DP_with_5120 -- C:"Program Files'
£ File Edit Insert PLC ‘Miew Options ‘Window Help

=10l x|
=18 x|

s R E P EE I__I

E- % GS_NFT2-DP_with_5120
= SIMATIC 30001)
=@ cPU 37T-2DP
: El-- 57 Program(1)
----- (] Sources

----- {ﬂ Blacks
I ‘fzd Technology
------ E SIMAMICS_S5120

Press F1 to get Help.

]

| < NoFiter >

|

[CPSE11(MPT)

Result: "Technological Objects Management" opens. The system automatically runs S7T Config if you
have not configured any technological objects yet, as in this example.
You may also run S7T Config without using "Technological Objects Management". Select the

"Technological Objects" object and then select the Options > Configure the technology command.

Save the current project data by selecting the Project > Save and recompile all command.

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
3 Change to the online mode by selecting the Project > Connect to target system command.
[+~ 57T Config - G5_317T2-DP_with_5120 ] |
Project Edit Imsert Target system Wiew Options ‘Window Help
ol N B X T A (e Y
Save Ctr+5
Save in old praject Farmat. ..
Check consistency Crl+alk-+
Save and compile
Save and recompile all
Download ko barget system
Properties. ..
Connect to targel tem
Discommect from target system
Print... Chrl+P
Print presies, .
Printer setup...
1 G5_317T2-DP_with_S5120 -- C:\Pragram Files\Siemens|Step?is7prafiGs_317T2
2 G5_317T2-DP_mit_S120 -- C:\Program Files\SiemensiStep?is7projiGs_31772
Exit Alc+F4
Technology |
n’; === Symbol browser IE Target system outputl
Saves the project, connects the project to the karget system and displays the consiskency status,  [0GiIT T=R L= MM v
4 In the project navigator, open the tree structure SIMATIC 300(1) > Technology > SINAMICS_S120 >
Automatic configuration. Open the automatic configuration by double-clicking "Automatic configuration".
o= S7T Config - GS_317T2-DP_with_5120
Projeck  Edit Insert Target system Wiew Options ‘Window Help
IEm R
I}
=8 §5_317T2-DP _with_5120
- Tnsert single drive
= SIMATIC 3001}
(== Technalogy
h_] EXTERMAL EMCODERS
7] CAMS
=l STMAMICS 5120
[ &} -omatic configuration
< Cwverview
- » Corfiguration
- > Topology
-ﬂm Contral_Unit
-] MONITOR
Technology I
Iixl . Alarms é Symbiol browser IE Target aystem output
Press F1 to open Help display. |0n|ine mode LM A
CPU 317T-2 DP: Controlling a SINAMICS S120
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
5 Start the automatic configuration in the "Automatic Configuration" dialog box by clicking the "Start
automatic configuration” button.
Automatic Configuration ﬂ
Status of the drive unit; IFirst COmmigzioning
Running operation; “Waiting for START

Start automatic configuration |

6 Set the drive object type for both motors to "Servo" and exit the dialog box with "Finish".

Drive Object Type

— Selection of the suppaorted drive object lwpes

f* Seryvo £ \ectar
Orive DOrive object type Identification
Diivee 1 Servo - Idertification wia LED
Ditive 2 Zervo j Identification via LED

< Zuriick I Fertig ztellen I Hilfe |

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result

7 The SINAMICS® training case on which this document is based has two different motor types. One of the
two motor types has DRIVE-CLIQ technology. The second motor/encoder is connected via SMC20, which
is why DRIVE-CLIQ recognizes that a second motor/encoder is present and creates this, but cannot
automatically configure it. Therefore, not all drive information can be completely configured automatically.
Confirm the warning with "OK".

Automatic configuration (ISD¥:413)

<y

Please remember to alzo configure the motors on the following drives:
SERVD_03
Please perform the following steps:

Go offline.
Run through the drive wizard on the appropriate drive and on the infeed if one iz available.

8 Close the "Automatic Configuration" dialog box by clicking "Close".

Automatic Configuration il

Statuz of the drive unit; IInitiaIizatiu:un finizhed

Runting operatiamn: Autarnatic canfiguration is
completed

llrrad] ter Bt [l Bl ]

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence

Activity | Result

9

Change to the offline mode by selecting the Project > Disconnect from target system command.
=10l x|

#=S7T Config - G5_317T2-DP_with_5120
Project Edit Insert Target system Wiew Options ‘Window Help

Ot a0 i [ | e e e @
Save Ctrl+5

Save in old project Format. ..
Check consistency

Save and compile

Save and recompile &l
Daownload ko target system
Propetties. ..

Chri+ale+

Connect ko targek syskem
Disconmect: from targ

Prink. ., Chrl+P
Print presiew, .
Prinker setup, ..

1 G5_317T2-DP_with_5120 -- C:\Program FilesiSiemensiStep?s7prafiGS_317T2
21G5_317T2-DP_mit_5120 -- C:Program FilasiSiemens\Step?is7profiGs_317T2

Exit Alt+F4

Technology I

I;I . Alarms | Z= Symbol browser IE Target spstem output E Load to PG output |

Disconnects From target system, [Online mode [ o 4
CPU 317T-2 DP: Controlling a SINAMICS S120
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence

Activity | Result

10

In the project navigator, open the tree structure SIMATIC 300(1) > Technology > SINAMICS_S120 >
Drives > Servo_03 > Configuration. Open the offline drive configuration by double-clicking "Configuration".
= S7T Config - G5_317T2-DP_with_5120 =10 x|

J | J I

Projeck Edit Insert Target system VWiew Options Window Help

S R N e e A s e = e )

| Sl8% S 5|5l ]| %] sl |

BB G5_317T2-DP_nith_5120

B Insert single drive
E-El SIMATIC 300(1)
B Technalagy
F- ] AYES
3 EXTERMAL ENCODERS
-] CAMS
=il SINAMICS 5120
ey Owverview
- Configuration
% Topalagy
- CU_004
a Inputfoutput component
Iél a Drives
) Insert drive
[ SERvO_02
|- [ SERMO_03

----- » Contral logic

-3 Open-loopfclosed-loop contral
- Functions

% Messages and monitaring
-3 Commissioning

- Communication

-3 Diagnostics

fn M B e B e O e W
JE R R KRk Rk

FE-{_] MONITOR,

Technalogy I

X ommam
= Symbol browser IE Target system output IE Load ta PG output I

Press F1 ta open Help display. Offline mode UM 4
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence

Activity

| Result

11

Click the "Configure DDS..." button to start the configuration.

=lolx|

™ Display data st Drrive data set: DDS 0 LConfigure DDS.. AddDDS.. Eemove DS, I
switchover Canfigure CDOS...
Canfiguration | Diive data setsl
M ame: ISEFND_DB Drive objects ype: SERYO [11)
Drive object no.: |3 Contral type: Speed control [with encoder) [21]
| DRIVE CLO) 1 PROFIBLS message frame:  Free telegram configuration with BICO (399)

SERYO_03 Motar_Module_3 [Power unit)

SERVO_03.Encoder_5 [Encoder 1]

Encoder data |

Component humber: 3

Power unit type: Drouble motor module 2]

Order no.: BELA20-2TE13-0d4%
Pawer unit rated current: 300 A
Power unit rated power: 160 ki

Current pawer urit operating values

|dertification via LED

SERYO_03.Motor_E [Moatar]

tator Synchronous motor (rotating, permanent-magnet]

Mo ligt data is available for the motor

Fiated matar speed: 0.0 rpm
Fiated motar torgque: 000 Mm
R ated motor current: 0oo A
Brake available: Mo
otor data setz [MDS] number: 1]

Reference vanables

Component number 5 ks 4
Encoder evaluation: SMC20 4
Type: SMC20
Order no.: B5L3055-04A00-568 4%
Idertification via LED |
Enc. type: Mo encoder [0]
Order na: B R N KRR

Encoder data set number:

Reference speed reference 3000.00 rpm
Reference voltage: 1000 W
Reference cument: 10000 A
Reference tarque: 1.00 M

1]

DDS:ID VI

ﬁl Cloze Help

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
12 Accept the default settings and click "Continue >".

Configuration - SINAMICS_S120 - Control structure
["EEEEEE Ove: SERVO_03.005 0

[CJPowmer_unit

[Itatar _ Function modules
g?:éz:j:rjldmg brske [T Extended zetpoint channel
[JFPROFIBUS process ds [T Technology contraller

IS urmmmany

[T Estended mezzages/moanitaring

— Cloged-loop control

Setp.t. C % p/M contral | _K

Contral method:

Speed cantral [with encoder] j

—&ctual speed value preparation——

@

< Back I Continue » I Cancel Help

CPU 317T-2 DP: Controlling a SINAMICS S120
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result

13 The power section has DRIVE-CLIQ technology and has already been correctly configured. Check the
order number and click "Continue >".

Configuration - SINAMICS 5120 - Power_unikt

] Control structure Drive: SERVO_03, DDS O

[Jhiotor Configure the power section component:
[t otar holding brake Compoanent Mame: IM.;.t.:.r_M adule_2
[JEncoder

[IFROFIBUS process d2 Copnection valkage: I 510 - F20%DC
CISumrmany

I
Coaling method: IInternaI air cooling j
=

Type: I Double motor modules

[~ Only dizplay double motar modules with free connections

_,I kdatar module zelection:

Code nu...
A8 A8 CAaC 100711
; BAMRA DCAAC 10012
BSL3120-2TE 21 D 4akw 9494 DCAAC 10013
B5SL2120-2TEZ1 -Bhus 97 kw 18A/18A  DCAAC 10014

Rated cur...

I:Irder ri.

<] | ]

= Mo filker/chake
£ Sinwzaidal filker
€ Dutput choke

< Back I Continue > I Cancel Help
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result

14 The SINAMICS® training case on which this document is based does not have an active infeed module.
Confirm the warning with "OK".

Connect Ready to run signal {IWIZ:16921)

& The Ready to run signal must be connected!

Caution, if the infeed iz contralled wvia anather CU. the Ready
ko run zignal of infeed r863.0 must be connected to "Bl
|nfeed Ready ta run zignal” of drive pB54 via digital
outpLteinputs.

If thiz iz not taken into conzsideration, damage to the infeed

rna resultl
15 Click the blue button and in the TB30_04 context menu, select digital input 0, which corresponds to
parameter r4022, bit 0. Then click "Continue >".
Configuration - SINAMICS_5120 - Power unit BICO R0 [11]

Drive: SERYO_03, D05 0 eed control [with encoder] [21]

[w] Contral struchure
[w] Frovver_unit

£ telegram configuration with BICO [999)

[ 1Power unit connection
1k atar Infeed in operation

Encoder data |
der 1
Ik otor holding brake Diive in neoder 1) 3
[CIEncoder le i operation
[CIFROFIBUS process dz v & SHMC20 4
JSummany 1 SMC20
cu_nn4 3 (P S AR

TE30_0¢4 r 0, c TB30 digital inputs, status: : DI 0 .17 (D=Low | 1=High}
r4022; Bit 1, CO/BO: TB30 digital inputs, status: : DI 1 (#481.2) (0=Low [ 1=High}
r4022: Bit 2, CO/BO: TES0 digital inputs, status: : DI 2 (®451.53) (0=Low | 1=High}
r4022: Bit 3, CO/BC: TESD digital inputs, status: @ DI 3 {(x481.4) {0=Low | 1=High}

ﬂ et Further interconnections...

Further interconnections. ..

< Back I Continue > I Cancel Help
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result

16 The motor without complete DRIVE-CLIQ technology is connected to terminal X2 of the power section.
Click "Continue >".

Configuration - SINAMICS 5120 - Power unit conneckion

[¥] Control structure Dinive: SERVO_03. DOS 0O
Powier_Linit
[V Power unit BICO Configure the power unit connections for the double
[ s rotar madule BSLIIZ02TE130adx  [Ln =34/ 34)
[Jtdatar
[t atar kalding brake | Connection] > used by SERVO_D2
[1Encoder batar: bator_SkI_3
[JPROFIBUS process de AFK T2 2w P
CISumrmany
@ Cannection 22
i

< Back I Continue > I Cancel Help
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
17 Select the correct motor from the list. To activate the selection option, you must select the "Select standard
motor from list" box.
The motor used in the SINAMICS® training case is the 1FK7022-xAK7x-xxxx. Check this against the
supplied documents or the motor type plate (lower motor - blue gear wheel). Select the appropriate motor
and click "Continue >".
[w|Contral stucture Dirive: SERYO_03, DDS 0. MDS O
[w] Ponaer_unit
[w] Fomwer unit BICO Configure the motor:
[w]FPowaer unit connechion Matar name: IMDtDr_E
[IMotor holding brake " Matar with DRIVE-CLIT interface
DIE';CEIDI:'::E[LIS ; [T | Beadaut mator, again
[ process 9 {* Select standard matar from list
1S ummary
™ Erter motor data
Mataor type: I'IFK? gynichronous mokor j
| | h ot lection:
- ﬂ ator gelection
I Rated SpEEdI R ated torg... | Rated curr. «
i wa  BOOO L, .6 Mm /
TFK P32k, T BOO0 Udmin 0,75 Mm 134
TFK P33k, T BOO0 Udmin 0,9 Mm 154
TFK P40k, 7 n BOO0 Udmin 1.1 Mm 1.7 A
TFK 7042t Pt 3000 Wdmin 26 Mm 1954
TFK T2k, Tt EOO0 Udmin 1.5 Mm 2454 —
TFK. 70430 H - 4500 Udmin - 2,6 Mm LYY
TFK P04 308k, P n BOO0 Udmin - 2Mm 4.4 4
TFK 7044t Pt 3000 Wdmin 3,5 Mm 4 4
TR F04 -0t H P 4500 Udmin - 3 Mm 494
TFK FOB0-mtF T 3000 Wimin 4.7 Mm 3T A
TFK.FOB0-miH 7 - 4500 Udmin 3,7 Mm 471 A
TFK.70BT s Pt 3000 Udmin 5.4 Mm B34
TFK.FOET -l H P 4500 Udmin 4.3 Mm FAA W
1| | »
¢ Back I Confinue = I Cancel | Help |
CPU 317T-2 DP: Controlling a SINAMICS S120
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
18 Select "Without holding brake" and click "Continue >".

Configuration - SINAMICS_S120 - Motor holding brake

Eﬂntrul Structure DriVE: SEHII\'IID_DS_. DDS |:|

Power_Linit
Poweer unit BICO
Poweer unit connection

b atar brake selechon:

[t b " With holding brake
_ 1K, Fm-wn-wmB
[CJEnzoder 1FE. Frmm-rms-nmH 5
[JFROFIBEUS process dz

[C1Summarny

+ fithout holding brake
ll_l LI TFE P mms-wete

TR Fmm-rms-nmG

Halding brake configuration:

IN::: rmiotor holding brake being uzed j

" | Extended|brake contral

< Back I Continue > I Cancel Help
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
19 Select 1FK7xxx-xxxxx-xAxx. Check this against the supplied documents and click "Continue >".
EDntrnl Structure Dri"v'E: SEHI'\'IID_DE_. DDS |:|_. MDS l:l
[w] Foumer_uinit
[P ””?t BICO _ wihich encoder do pow want bo uze?
belPawer unit connection ¥ Encoder [ Encoder 2 [ Encoder 3
[w]tdatar
[wtdotor halding brake Encoder 1 |
[JFPROFIBUS process ds Encoder name; IM-::tu:ur_E
IS urmmmany
¥ Select motor encader from list
=) Enter data Ercoder, data |
Matar encader zelechion:
K M :
Type [arder no.] | Encoder type | R ezalution | Code... |
1FE. Sindcozincr... 2048 5/H
1FK Pumu-smm-wEw EnDoat abzol... 2048 5/R 2051
i TFE Fsm-mmweme-waw - EnDat absal.. 32 5/R 2062
TFE 7 wum-mmee-wHu - EnDat absol..  B125/R 2053
g \ TFE Fe-mm-5 s Fesalver n-zpeed 1003
@l} b | TFE P rm-mmm-n T o Fesolver 1-zpeed 10
S\
< Back I Continue » I Cancel Help
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
20 Set the PROFIBUS message frame to "SIEMENS telegram 105 (105)" and click "Continue >".

Configuration - SINAMICS_S120 - PROFIBUS process data exchange (d

[ Control structure Dinive: SERWO_03, DDS 0O

Power_Linit
Poweer unit BICO
Poweer unit connection
b ki

b abar kiolding brake
Encoder

15 umrmany

Select the PROFIEUS meszage frame type:

FROFIBUS FZD message frame: |[3Y1sal = e =eE iy

Input data [waordsz): |-| i
4 I I _'I Output data [words]: |1 i

M otes:

1. The PROFIELS process data will be interconnected to BICO
parameters in accordance with the selected mezzage frame ype.
Theze BICO parameters cannot be subzequently changed.

=S\

< Back I Continue > I Cancel Help
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence

Activity | Result

21

Click the "Finish" button to exit the offline configuration of the drive.

Configuration - SINAMICS_S120 - Summary

[w]Control structure The following data of the drive has been entered:

[w] Foumer_uinit -
) Control structure: .
[w]Fower unit BICO Contral tppe: Speed conbal [with encoder] _I
[w]Fowmer unit connection Power unit componett:
W]t otar Component name: Motor_kodule_2
: Component lype: Double motor module

AN otor holding brake Order no.: BSL3120-2TE 1 3-0ées
[IE ncoder Fated power; 1.5 ki
WIPROFIBUS process dz Rated cument: 34 7 34
Power unit BICO:
Fower unit connection:
P otor:

kaotor name: Motor_G

Mator type: TFEY sunchronous motar

Order no.: TR FO22-mA K Fr-mm

Fated speed:; B000 U min

Rated tarque: 0,6 Mm

Fated curent: 1,26 &
Maotor holding brake:

kator holding brake: Mot available
Encoder:;

Encader name: Matar_&

Motor encoder order no.: TEE - ws-ri
FROFIBLIS process data exchange [dive]:

PROFIBUS FZD meszage frame: SIEMEMNS telegram 105 [105]

Copy text to clipboard |

< Back

Cancel Help
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
22 The offline configuration of the drive is completed. Close the dialog box with the "Close" button.
o
 Display deta set Drive data set: DOS D Configuie DDS. . AddDDS.. | | Hemovenns. |
switchover Canfigure COS...
Configuration | Drive data sets'
Mame: ISEFND_U3 Dirive objects type: SERYO [11]
Drive object no.: |3 Contral type: Speed control [with encoder] [21]
| DRYE CLIL i PROFIBUS message frame:  SIEMEMS telegram 105 [105)
SERVO_03 Matar_Module_3 (Pawer i) SERVO_03 Matar_E [Encader 1] Eirrmtzs kit
Component number: 3 |Component number 5 ks 4
Pawer unit tppe: Double motor module (2] |Encoder evaluation: SMC20_to_Motor_B
Order na.: BELA20-2TE13-084x Tupe: SHC20
Power unit rated current: 300 A Tl mme £5L3055-04A00-5 %
Power unit rated power: 1.60 kw — -
|dertification via LED! I
Current power unit operating values
T Ene. type: ratary, 2048, 1 Vpp, A/ C/D R (2001)
|dentification wia LED
Order ho.: TR 7 HsH-RRH - R
SERVO_03.Motor_& (Matar) Rotary encoder pulse Mo.: 2042
Matar 1FKT synchronous mator (237] | Epcader data set number: 1]
Order no.: TFR 7022 Rk Fa-rtnx
Rated motor speed: EOO0.0  rpm
Fiated motar tarque: 0.E0 Mm
Rated matar current: 140 A
Brake available: Mo
ator data setz [MDS) number: 1]
Reference variables
Reference speed reference 3000.00 rpm
Reference woltage: 1000 W
Reference current: 100.00 A
Reference tarque: 1.00 Mm
DDS:ID vI ¢-| Close Help
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
23 In the project navigator, open the tree structure SIMATIC 300(1) > Technology > SINAMICS_S120 >
Drives > Servo_03.
Right-click to open the context menu and select Expert > Expert list.
E-S7T Config - GS_317T2-DP_with_S120
Project  Edit  Insert Target swstem  Wiew Opbions wWindow Help
“u b EZ = i
| sl@m)| 2] &=l o] W] =l | | 25| B | FIEin=
=
HISERYD_03 - Configuration
=B G5_317T2-0P_with_5120
- Insert single drive
|_t_|... SIMATIC 300(1) v Display data sat Dirive data zet: DDS
El-- Technology awitchower
-] ARES
[#-_] EXTERMAL ENCODERS L .
il Drive data zetz
_| CAMS Configuration | I
=-ffla SIMAMICS_S120 Marme: [SERvO_03
----- S Owverview . .
] bject no.: 3
----- » Configuration S gl I
""" > Topology | DRIVE CLid
El-Ey CU_004
% Configuration
» Conkrol logic
8= Inputsfoutputs SERYO_03.Mator_Module !
¥ Communication Camponent number;
B » Diagnastics Power unit type:
EEI--E Input/output component Ord ;
l_:_la Drives Tder fo.:
il Insert drive FPower unit rated curent;
@ 3ERVOD_02 FPower unit rated power:
= o EEAP
i Drive RV Current paower
) Config PEstE Identifi
- > Contr Celete
[+ ¥ Cpen- SERYD_D3.Matar_B& [Motar)
: Rename
- B Funct [k
- D Mess: Experk list
B Comr ] i Save project and export object
=3 Comm Drive navigatar Frated motor speed,
= ; Cpen configuration !
» Diagn P g Rated motor tarque:
-] MONITOR Control lagic
Cpen-loopjclosed-loop contral  k Fated matar current:
CPU 317T-2 DP: Controlling a SINAMICS S120
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
24 Select parameter "p210" and enter "345".
[ SER¥D_03 - Expert list ] 5
| mlsal|| wlEli] TS

Expert list |

Parameter D | + | + |Parameter text Value SERVO_03 Unit | Changeabl Acces Minimum Maximum ;I

p201[0] P Povver module code number (10011 - Commizsioni |3 ] ES535

r203[0] P Actual powwer module type SIMNAKMICS S (1007 3 |

r204{0] P + |Powver module properties 1H - 3

r206[0] + Rated power module power,  [1.60 Ky 2

r207[0] + Rated power module current, [5.00 A 2

r208 Rated povver module line supp (400 W 2

r208[0] + Povver module, maximum curr [5.60 iy 2

p210 Drive unit line supply voltage ] W Ready torun 3 1 1200

Rp287[0] + Ground fautt monitoring, thres (6.0 % Ready to run 3 o 100

r289 Maximum povver module outpu (5.00 A 3

290 Powver module overload respo ([Reduce output current or n;l - Ready torun| 3

p294 Povver module alarm with [2t o[95.0 g Operation |3 10 100

p2a5 Fan run-on time u] = Operation |1 a E00 LI
nnnnnn P, . .- P—— . . - (| - - - ol

The smart line module and the motor module of the SINAMICS S120 training case have been especially
equipped for operation on a 230 V system. For this reason, "Parameter p210" of the connected drives must
be set to the following value, which differs from the factory settings:

p210 = 345 V device connection voltage SERVO/VECTOR

The setting of "parameter p210 = 345 V" cannot be calculated by the SINAMICS operating system and is
pre-assigned for the error-free operation of the SINAMICS S120 training case on the 230 V system.
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence

Activity | Result

25

In the project navigator, open the tree structure SIMATIC 300(1) > Technology > SINAMICS_S120 >
Drives > Servo_02 > Configuration. Double-click "Configuration" to open the offline drive configuration.
#=+S7T Config - G5_317T2-DP_with_S120

=10l x|

Project Edit Insert Target system View Options Window Help

| ]| 5] ] o = 2] o | 5]

B

0 o o 2 s e A e

b4
-3 G5_317T2-DP_with_5120

M7 Insert single drive
- sIMATIC 300013
=-EE Technalogy

B AXES

(-] EXTERNAL ENCODERS

- CAMS

E-ffla stMamMIcs_s120

e 3 Civervien

L % Configuration
» Topalagy
i-Em CU_004
a Input{output component
=1-55) Drives

L) Insert drive
S SERMO_0Z
-4 Drive navigator
Configuration
----- % Contral lagic
- % Open-loop/closed-loop cc
- % Functions
-3 Messages and monitoring
[+~ 3% Commissioning
e
[+

- Communication
- Diagnostics
-l SERWO_O3

-] MONITOR

1] | Bl
Technology I

n"' = Symbol browser I

Press F1 to open Help display.

Offline mode [ [ A
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
26 Start the configuration by clicking the "Configure DDS..." button.
TR
 Display deta set Drive data set: DOS 0 Configuie DDS. . AddDDS.. | | Bemovenns. |
switchaver Canfigure COS..
Drive data etz I
Mame: ISEFND_U2 Dirive objects type: SERYO [11]
Drive object no.: |2 Contral type: Speed control [with encoder] [21]
DRIVE CLiQ PROFIBUS meszage frame:  Free telegram configuration with BICO [939)
SERYO_02 Mator_Module_2 [Pawer unit] SERVO_D2 Encoder_8 [Encoder 1) Encoder data |
Component humber: 2 Component number 5 kx: 7
Power unit lype: Double maoter module (41] | Encoder evaluation: SMI20_7
Order no.: BELA20-2TE13-084x Tupe: SMIZ0
Power unit rated current: 300 A Tl mme BSL3055-04A00-5hw
Power unit rated power: 1.60 kw — -
|dertification via LED! I
Current power unit operating values
. - Enc. type: rotary, 512, 1 vpp, A/8, EnD at, Multiturn 4096 [2053)
|dentification wia LED
Order ho.: T FF 7 -l 4
SERVO_02 Motor_Sh|_3 [Muotar] Rotary encoder pulse Mo.: 512
Matar 1FKT spnchranaus mator (237] | gicgle-tum resolution: 8192
vt TIRSAIZZ AT | o esaltian 4096
Fated matar speed: BOO0.0  rprm Ercoder data set number o
Fiated motar tarque: 0.E0 Mm
Rated matar current: 140 A
Brake available: Mo
ator data setz [MDS) number: 1]
Reference variables
Reference speed reference B000.00 rpm
Reference voltage: 1000 %
Reference curent: a0 A
Reference torque: 1.38 Mm
DDS:ID vI ¢-| Close Help
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
27 Accept the default settings and click "Continue >".

Configuration - SINAMICS_S120 - Control structure
["EEEEEE 0= SERVO_02.005 0

[CJPowmer_unit

[Itatar _ Function modules
g?:éz:j:rjldmg brske [T Extended zetpoint channel
[JFPROFIBUS process ds [T Technology contraller

IS urmmmany

[T Estended mezzages/moanitaring

— Cloged-loop control

Setp.t. C % p/M contral | _K

Contral method:

Speed cantral [with encoder] j

—&ctual speed value preparation——

@

< Back I Continue » I Cancel Help
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Learning units
3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result

28 The power section has DRIVE-CLIQ technology and has already been correctly configured. Check the
order number and click "Continue >".

Configuration - SINAMICS 5120 - Power_unikt

W Control structure Drive: SERVO_02, DDS O

[Matar Configure the power section component;

[t otor holding brake Component Mame: IM otar_Madule_2

[JEncoder

[IFROFIBUS process d= - Connection valtage: I 510- 720D j

1S urnrnary
Coaling method: IInternaI air cooling j
Type: I Double mator modules j

[~ Only dizplay double motar modules with free connections

_,I kdatar module zelection:

Code nu...
10071
: A /AN 10mez
BSLITZ20-2TEZT-04m 48 KWw 34 /34 DCAC 10013
BSLIZ0-2TE2T-BAwme 9.7 kW 18A /. DCAC 10014

Rated c.

I:Irder ri.

= Mo filker/chake
£ Sinwzaidal filker
€ Dutput choke

< Back I Continue > I Cancel Help
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Learning units
3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
29 The SINAMICS® training case on which this document is based does not have an active infeed module.
Confirm the warning with "OK".

Connect Ready to run signal {IWIZ:16921)

& The Ready to run signal must be connected!

Caution, if the infeed iz contralled wvia anather CU. the Ready
ko run zignal of infeed r863.0 must be connected to "Bl
|nfeed Ready ta run zignal” of drive pB54 via digital

outpLteinputs.
If thiz iz not taken into conzsideration, damage to the infeed

rna resultl
30 Click the blue button and in the TB30_04 context menu, select digital input 0, which corresponds to
parameter r4022, bit 0. Then click "Continue >". -

Configuration - SINAMICS_S120 - Power unit BICO . . .
Free telegram configuration with BICO [399)

W] Contral structure Drive: SERVO_02, DDS O

Power_unit

5 \ 3 [Encoder 1) Encoder data |
M 7

[CPower unit connection

I ator Infeed in operation SHI20_ 7

[t atar haolding brake Dirive in

JEncoder DI i] operation 5120

CIPROFIBUS process de v & BSL3055-0AA00-5k xx
S —

(Joummary 1 Idertification via LED |

TB30_04 r it 0, TB30 digital inputs, status: : DI O | .13 (D=Low | 1=High}

eDr . r4022: Bit 1, CO/BO: TB3O digital inputs, skatus: @ DI 1 (¥481.2) (0=Low | 1=High]
r4022: Bit 2, COJEO: TE3D digital inputs, stakus: : DI 2 (¥481.3) (O=Low | 1=High)

r4022: Bit 3, COJBC: TESO digital inputs, status: : DI 3 (x481.4) (0=Low [ 1=High)

Further interconnections. ..

< Back I Continue > I Cancel Help
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Learning units
3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
31 The motor with complete DRIVE-CLIQ technology is connected to terminal X1 of the power section. Click
"Continue >".

Configuration - SINAMICS 5120 - Power unit conneckion

[¥] Control structure Dinive: SERVO_0Z2, DS 0O
Powier_Linit
[V Power unit BICO Configure the power unit connections for the double
[ s rotar madule BSLIIZ02TE130adx  [Ln =34/ 34)
[t otor g .
[Motor holding brske | € Cannection;
[JEncoder
[JPROFIBUS process de
CISumrmany
{ Conpection =2 - uzed by SERWO_03
kdatar; kdatar_B
| TFKTO22-0AK Fr-sebaes

< Back I Continue > I Cancel Help
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
32 The motor with complete DRIVE-CLIQ technology has already been correctly configured. Click
"Continue >".
W] Cantral stucture Drive: SERYO_02. DDS 0. MDS O
[w]Fowwer_uinit
[w]Fowmer unit BICO Configure the matar:

[w]Fower unit connechion

Tr— 0 [T

[CItatar halding brake " hdotor with DRIWVE-CLIG interface
EE;'ED;:ETUS . [T Read out motor again
i Process az " Select standard matar from list

™ Enter matar data

Fotor type: I'IFKF" gynichronous mokor j

< Back I Confinue » I Cancel Help
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Learning units
3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
33 Click "Continue >".
Configuration - SINAMICS_S120 - Motor holding brake
Eﬂntrul Structure DriVE: SEHII\'IID_DE_. DDS |:|
[w] Pioneer_Linit

Poweer unit BICO
Poweer unit connection

b atar brake selechon:

[t b € Wit holding brake
_ 1K, Fm-wn-wmB
[CJEnzoder 1FE. Frmm-rms-nmH 5
[JFROFIBEUS process dz

[C1Summarny

¥ without holding brake

LI_I LI 1FE T sttt

TR Fmm-rms-nmG

Halding brake configuration:

IN::: rmiotor holding brake being uzed j

" | Extended|brake contral

< Back

Cancel Help
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
34 The correct encoder has already been correctly configured by means of DRIVE-CLIQ technology. Click
"Continue >".

Configuration - SINAMICS 5120 - Encoder

W] Control structure Drive: SERYO_02. DDS 0. MDS O
[w]Fowwer_uinit

[v]Fower unit BICO Which encoder da pou want to use?
[w]Fower unit connechion

v Encoder |
Motor ¥ Encoder
[w]tdotor holding brake Encoder 1 |

[JFPROFIBUS process ds Encoder name; ISMI:ZEI_?
IS urmmmany

[~ Encoder 3

% |ntegrated encoder evaluation

€ Enter data Encoder data

i

Type [order no.] | Encoder type | Fiezolution | Code... |

EnDat abzol.. 512 5/R 2053

< Back I Confinue » I Cancel Help
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
35 Set the PROFIBUS message frame to "SIEMENS telegram 105 (105)" and click "Continue >".

Configuration - SINAMICS_S120 - PROFIBUS process data exchange (d

[ Control structure Dinive: SERWO_02, DDS 0O

Power_Linit
Poweer unit BICO
Poweer unit connection
b ki

b abar kiolding brake
Encoder

15 umrmany

Select the PROFIEUS meszage frame type:

FROFIBUS FZD message frame: |[3Y1sal = e =eE iy

Input data [waordsz): |-| i
4 I I _'I Output data [words]: |1 i

M otes:

1. The PROFIELS process data will be interconnected to BICO
parameters in accordance with the selected mezzage frame ype.
Theze BICO parameters cannot be subzequently changed.

=S\

< Back I Continue > I Cancel Help
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
36 Click the "Finish" button to exit the offline configuration of the drive.
[w]Control structure The following data of the drive has been entered:
[w] Foumer_uinit -
) Control structure: ;I
[w]Fower unit BICO Contral tppe: Speed conbal [with encoder]
[w]Fowmer unit connection Power unit componett:
W]t otar Component name: Motor_kodule_2
: Component lype: Double motor module
E”t”dhc"d'”g brake Order no.: BSL3120-2TE 1 3-0ées
ncooEr Fated power; 1.5 ki
[WIFROFIEUS process dz Fiated cument: 34 /3 4
Power unit BICO:
Power unit connechian:
P otor:
kotor name: SkI20_7
Mator type: Motor with DRME-CLIG interface
kdatar holding brake;
Mator holding brake: Hot available
Encoder:
Encoder name; SkI20_7
Fatar encader order na: TRE. Fee-swme-sl
PROFIBUS process data exchange [dive]:
FROFIBLS FED meszage frame: SIEMEMS telegram 105 [105]
Copy text to clipboard |
< Back Cancel Help
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
37 The offline configuration of the drive is completed. Close the dialog box with the "Close" button.
o
 Display deta set Drive data set: DOS D Configuie DDS. . AddDDS.. | | Hemovenns. |
switchover Canfigure COS...
Configuration | Drive data sets'
Mame: ISEFND_U3 Dirive objects type: SERYO [11]
Drive object no.: |3 Contral type: Speed control [with encoder] [21]
| DRYE CLIL i PROFIBUS message frame:  SIEMEMS telegram 105 [105)
SERVO_03 Matar_Module_3 (Pawer i) SERVO_03 Matar_E [Encader 1] Eirrmtzs kit
Component number: 3 |Component number 5 ks 4
Pawer unit tppe: Double motor module (2] |Encoder evaluation: SMC20_to_Motor_B
Order na.: BELA20-2TE13-084x Tupe: SHC20
Power unit rated current: 300 A Tl mme £5L3055-04A00-5 %
Power unit rated power: 1.60 kw — -
|dertification via LED! I
Current power unit operating values
T Ene. type: ratary, 2048, 1 Vpp, A/ C/D R (2001)
|dentification wia LED
Order ho.: TR 7 HsH-RRH - R
SERVO_03.Motor_& (Matar) Rotary encoder pulse Mo.: 2042
Matar 1FKT synchronous mator (237] | Epcader data set number: 1]
Order no.: TFR 7022 Rk Fa-rtnx
Rated motor speed: EOO0.0  rpm
Fiated motar tarque: 0.E0 Mm
Rated matar current: 140 A
Brake available: Mo
ator data setz [MDS) number: 1]
Reference variables
Reference speed reference 3000.00 rpm
Reference woltage: 1000 W
Reference current: 100.00 A
Reference tarque: 1.00 Mm
DDS:ID vI ¢-| Close Help
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Learning units

3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
38 In the project navigator, open the tree structure SIMATIC 300(1) > Technology > SINAMICS_S120 >
Drives > Servo_02.
Right-click to open the context menu and select Expert > Expert list.
B~ S7T Config - GS_317T2-DP_with_S120
Project Edit Imsert Target syskem  Wiew Options  WWindow  Help
~u b EZ it
| SR 2| 5|2 o] «] ]| =% || 2l | H ==
—_—
El--% 5_317T2-DP_with_5120 EISER'!‘D_I]Z - Configuration
-] Insert single drive
EI--- SIMATIC 300(1) Display data set Dirive data zet; [
El-- T\echnnlugy v switchover
-] ARES
-] EXTERNAL ENCODERS —— :
F-_] CAMS Configuration | Diive data zets |
=-fla SINAMICS 5120 Name: [SERVD_02
----- > Overview ; _
_____ % Configuration Dirive object nio.: |2
[_;; ;‘EF‘?}'E?" | DRIVE CLiD
% Configuration
- 3 Control logic
&= Inputsfoutputs SERYO_02 Maotor_Madi
- B Communication Component number;
-3 Diagnostics Poweer unit type:
EEI--a Input/output component '
Ela Drives Order hio.:
i| Inserk drive Paower urit rated current
=~ ﬁ' m o Poweer unit rated power:
; ﬁ‘ Drive R
% Confi FESEE Current pc
; g:untr Celete [de
pen
Rename
B Funct SERV N2 SMIZN 7
M Messi Expert list
2 Comm ] ] Save project and export objeck
#- 3 Comm Drive navigator .
-3 Diagn CIpEn canFlguratlnn Rated moter speed:
Eﬂ"'@ SERNWO O Control logic
EH:' MIONITOR Open-loop)closed-loop control  k Riated motor targue:
Functions » Rated motor curent:
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
39 Select parameter "p210" and enter "345".
=
| |5l | FlE[a] ] ||
Expert list I
Parameter | | + | + |Parameter text Un'rt Changea Acce Minimu  (Maximu ;I
r206[0] + Rated povwer module po (1 60 K 2
r207[0] + Rated povwer module cur | 3.00 Ly 2 = |
r205 Rated povwer module line |400 W 2
r209[0] + Powver madule, maximum A 2
p210 Drive unit line supgly wolt |SEE W Feadytor| 3 1 1200
p2EF[0] + Ground fault monitoring, t{E.0 % Readytor|3 ] 100
r289 Maximum power module |E.00 LY 3
290 Pavver madule overlasd r|Feduce output curren;l - Feady tar| 3
p294 Powver madule alarm wit (250 k= Operation |3 10 100
P93 Fan run-on time ] = Operation |1 ] GO0
p300[0] I Mt type selection 1FKY synchronous m ;l - Commissial 2
P30T [0] Il Wotar code number sele (23726 - Commiszio) 2 1] B5535
r302[0] Tl hlotar code number of int|23726 - 2 ;I
The smart line module and the motor module of the SINAMICS S120 training case have been especially
equipped for operation on a 230 V system. For this reason, "Parameter p210" of the connected drives must
be set to the following value, which differs from the factory settings:
p210 = 345 V device connection voltage SERVO/VECTOR
The setting of "parameter p210 = 345 V" cannot be calculated by the SINAMICS operating system and is
pre-assigned for the error-free operation of the SINAMICS S120 training case on the 230 V system.
40 In the project navigator, open the tree structure SIMATIC 300(1) > Technology > SINAMICS_S120 >

Configuration. Double-click "Configuration" to start the SINAMICS® configuration.

¥~ 57T Config - G5_317T2-DP_with_5120 -3l =|
Project  Edit  Insert  Target swskern  Wiew  Opkions  Window  Help

| |8l 1] e ] o] ] 2| sl e || 25 |

x

IR EEE =

=8P G5_317T2-DP _with_5120

LB Insert single drive

=B SIMATIC 30001}
=1-E#@ Technology
&1 ANES
'] EXTERMAL ENCODERS
-] CAMS
= fila samics_siz0
e Overview
(S - Figuiration
% Topology
¥y CU_004
a Input/output component
E‘E Drives
L Insert drive
H- [ SERWO_0Z
B SERYO_D3
FE-{_7] MOMITOR

Technology I

X = Gymbol b
o Hrnbol Drowser

Press F1 ko open Help display, Offline mode LI |7
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
41 In the "SINAMICS_S120 - Configuration" dialog box, set both message frame types to "SIEMENS telegram
105" and then click the "Align with HW Config" button.
M sINAMICS 5120 - Configuration — ol x=|
{ PROFIBUS meszage frame I Wersion Dvewiewl
The diive objectz are supplied with data in the following zequence from the PROFIBUS meszsage frame:
Object|Drive object|-Ho. Message frame type | address |0 address| Axis
1 SERWO_02 |2 SIEMEMS telegram 105 286,259 | 286, 259 |-
2 SERWO_03 |3 SIEMEMS telegram 105 e b
3 TE30_04 4 Free message frame configuration with BICO | —..— —_— - = I
4 CU_0o4 1 Free message frame configuration with BICO | —..— —_— -
The /0 configuration must still be aligned with the master configuration. Align with Hw Conlig |
Cloze | Help |
42 Close the "SINAMICS_S120 - Configuration" dialog box by clicking "Close".
M sINAMICS_S120 - Configuration =101 x=|
PROFIBEUS message frame | Yersion Dverviewl
The diive objects are supplied with data in the following sequence from the PROFIBUS message frame:
Object|Drive object|-Ho. Message frame type | address |0 address| Axis
1 SERWO_02 |2 SIEMEMS telegram 105 v | 256 275 | 2BE.2TS |-
2 SERWO_03 |3 SIEMEMS telegram 105 276295 | 276,295  |---
3 TE30_04 4 Free meszage frame configuration with BICO | —..— —_— -— = I
4 CU_0og 1 Free meszage frame configuration with BICO | —..— —_— -—
Align with HW Config |
Cloze | Help |
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
43 Select the Project > Save and recompile all menu command to save and compile the entire technology
project.

B=S7T Config - GS_317T2-DP_with_S120 -0 =]
Project  Edit  Imsert Target swskem  Miew Options  Window  Help

S R T T

Close

Save Chrl+5
Save inold project Format., ..
Check consistency Chrl+alk+E

Save and compile

Download b barget system
Properties, ..

Conneck ta Earget system
Discommect from target system

ik, oo Chr| P
Print previen., .
Prinker setup...

1 G3_317T2-DP_with_5120 -- Ci\Program Files!,Siemens\Step?sTprofias_317T2
2 @5_317T2-DP_mit_5120 -- C:\Program Files\Siemenst Step?is7prajiGs_317T2

Exit Alc+F4

Technolagy I

* === Symhbal Browser

m | ]
Saves the current project, deletes all compilation results and compiles all saurces in e (8T = ML ”/:
44 Select the Project > Connect to target system menu command to switch to online mode.
=577 Config - GS_317T2-DP_with_5120 _1Ol x|
Project  Edit  Insert  Target system  VWiew Options ‘Window Help
Slpe““' cirko e | [ Ve |22 ] e [ | L
0se

Save Chrl+5
Save in old project Format. ..
Check consistency Chrl+Al+E

Save and compile

Save and recompile all
Download bo taraet system
Properties...

Connect ko target
Discommect from Earget system

Print. .. Ctrl+P
Print preview. ..
Printer setup. ..

1 G5_317T2-DP_with_5120 -- C:\Program Files\Siemens\Step?|s7projiG5_317T2
21G3_317T2-DP_mit_5120 -- C:\Program Files\Siemens\Step7\s7projiGs_317Tz2

Exit alk+F4

Technology I

K mmmn
= Symbal browser | B Target system output |
Saves the project, connects the project to the targek syskem and displays the consistency status,  (037{IN TR0 [ LM 4
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
45 The desired configuration is on the PG/PC. Click the "<== Download" button to transfer the configuration to
the drive.
Online /offline comparison ﬂ
The configuration of SIMNAMICS 5720 [ DVCUE20S ] online differs  fram the project saved aoffline. The
following differences have been detected:
[Cfflire Differences
online topology Project topology
CL_004 ( TOCHURRS 1 [CU_004 { TOCtHURRS )
SERWO_02 { TOServoSL 1 [SERVO_02 [ TOServosSL )
SERWO_03 { TOServoSL ) [SERVO_03 [ TOServosL )
If these differences are not adjusted, the online reprezentation may be incomplete.
Bdjust via:
== Daownload Owerwriting of the data in the target device
Load to PG == Owenwiting of the data in the project
SIMAMICS 5120 I
oo _|
46 Confirm the safety query with "Yes".
Download {WDSI:0})
; The data will be downloaded!
Are you sure?
Tes Mo
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence Activity | Result
47 Close the dialog message with "OK".

Download (WDSI: 760)

; The data haz been succeszfully downloaded to the target spstem.

48 Close the dialog box with "Close".

Online/offline comparison x|

The configuration of SINAMICS 57120 [ DVCUZE205 1 online differs  from the project zaved affline. The
following differences have been detected:

Offline Differences

Online topology Project topology

CU_004 { TOChIUnitS ) CU_004 ¢ TOCHInits )
SERWO_02 [ TOSeryosSL )| SERVO_02 [ TOServosL )
SERWO_03 [ TOServoSL 1| SERVO_03 [ TOServosL )

|f theze differences are not adjuzted, the onlineg reprezentation may be incomplete.

Adjust via:
<== Dawnload Dwenwriting of the data in the target device

Load to PG ==> Denariting of the data in the project

SINAMICS_S5120 I

|
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3.9 9. Step. Configuration of the SINAMICS drive with S7T Config

Sequence

Activity | Result

49

Select the Project > Disconnect from target system menu command to switch to offline mode.
= STT Config - G5_317T2-DP_with_5120 = |D|ﬁ|

Project Edit Imsert Target system Wiew Options ‘Window Help

oo S 5 et 2 i e [ B =i il L

Close

Save Ctr+5
Save in old praject Farmat. ..

Check consistency Crl+alk-+
Save and compile

Save and recompile al

Download ko targek syskem

Properties. ..

Cannect to karget system
Disconnect From target system

Print... Chrl+P
Print presies, .
Printer setup...

1 G5_317T2-DP_with_S5120 -- C:\Pragram Files\Siemens|Step?is7prafiGs_317T2
2 G5_317T2-DP_mit_S120 -- C:\Program Files\SiemensiStep?is7projiGs_31772

Exit Alc+F4

Technology |

n’; . Alarms | Z= Symbol browser |E Target system output E Load to PG output |
Disconnects Fram karget system, [Online mode MM i

50

Activate the check boxes "Copy RAM to ROM" and "Load changes to PG/PC". Then confirm with "OK".

Disconnect from Target System

j Data hasz been changed in the following target systems:

SINAMICS_5120
SERYO_02
SERvO_03

Before disconnecting, for the changed data
W Copy RiaM to ROM
¥ Load changes to PG/PC

| ] 4 I Cancel Help |
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3.10 10. Step: Configuring the axes with S7T Config

3.10 10. Step: Configuring the axes with S7T Config

Important information

In this step, you create your technology objects (e.g. axes) with S7T Config. Use
"Technology Objects Management* to generate a technology DB for each TO. Do not copy

the technology DBs in order to ensure a defined assignment between the technology DB and
its TO.

Procedure

Sequence Activity
1

| Result

In the project navigator, open the tree structure SIMATIC 300(1) > Technology > AXES. Double-click
"Insert axis" to start the axis wizard:

[#==S7T Config - GS_317T2-DP_with_S120

=10l x|
Project Edit Insert Target system View Options Window Help
| (e8] S 5 [l [l 2| | =l || 2| | Bl | 3=l s )

*._] Insert single drive ;l
=-[@8 SIMATIC 300(1)
=-E@ Technalogy
B A¥ES
?_‘| Insert axis
[#-_) EXTERNAL ENCODERS
eI
= fllp SMNAMICS_S120
ey Owerview
% Configuration
» Topology
F-Emg CU_004
a Input/oukput component
Ea Drives
- Insert drive ;I

Technology I

XK mmmm
o= Symbal browser E Target system output |

Press F1 to open Help display.

Offline mode [Tz
Result: The “Insert Axis" dialog box opens.
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3.10 10. Step: Configuring the axes with S7T Config

Sequence Activity | Result
2 Confirm the default technology selection (speed control, positioning) with "OK".

insert s 2 x|

&

General I

‘which technolagy d tho use?
ich technology do you want bo uze Author |

[w]Speed contral YYerzion: I
[w|Pozitioning -

(15 ynchronous operation

E sisting Axes

Comment: :I

[

Cancel | Help |

Result: The "Axis Configuration - Axis_1 — Axis Type" dialog box opens.
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3.10 10. Step: Configuring the axes with S7T Config

Sequence Activity | Result

3 Accept the "Axis type: Linear, electric" and "Motor type: standard motor". Confirm with "Continue".
Axis configuration - Axis_1 - AXis type El

Axiztype: | % Lingar * Electrical
™ Ratany i~ Hydraulic
[10rive azzignment  Vittual
[JEncoder azsignment
[CJCompletion
-
kdatar type: | Standard motor j
"r'ou can zelect the axiz tpe on thiz page. ﬂ

Cautionl
Changing this entry can cause loss of aready set data as the
gtructure of the configuration data changes.

< Back I Contiriue > I Help |

Result: The "Axis configuration - Axis_1 - Units" dialog box opens.
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3.10 10. Step: Configuring the axes with S7T Config

Sequence Activity Result
4 Confirm with "Continue".
Axis configuration - Axis_1 - Units El
[W]siz bupe I it
Phy=ical quantity Unit =
[1Drive azzignmment et - mm .
[JErcoder assignment Incrementsfostion 1000t
[JCampletion Welocity mimis
Acceleration il
Jerk IS
Ratio %
Time =
Speed 1tz
Leadzcrew pitch mimsrot
Angle ° LI

Caution | ;I

[f you change the system of units, the configuration and system

variables will be converted [rounding errors are poszible] but the data

iti the pragrams will naot be considered. _I
w,

< Back I Cottinue > I Help |

Result: The "Axis configuration Axis_1 - Modulo" dialog box opens.
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3.10 10. Step: Configuring the axes with S7T Config

Sequence Activity | Result
5 Confirm with "Continue".
Axis configuration - Axis_1 - Modulo El

[10rive azzignment — Modulo axiz
[JEncoder azsignment
[ Completion Act, poz. value starts again at ||:|_|:| mrn [Modula start value]
Or after I'I 0ao.0 mm- [Modula length)
“r'ou zpecify the value range of the encoder on thiz page. :I
[e

< Back I Contiriue > I Help |

Result: The "Axis Configuration - Axis_1 Drive Assignment" dialog box opens.
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3.10 10. Step: Configuring the axes with S7T Config

Sequence Activity Result
6 Click the "Align Sinamics devices..." button.

Axis configuration - Axis_1 - Drive assignmenk El

"Which drive unit are you uzing?

irtual axiz - no drive connected

[JCompletion Aligh Sinamics devices. ..

r Mo longer digplay
infarmatian far real akes

“'ou can establish the connection to a dive on thiz page. For a diive =

L4

< Back I Cottinue > I Help |

7 Select the "SINAMICS_S120" device and click "Align".

Device Alignment X|

Pleaze zelect the devices to be aligned fram the list:

| Device I
SIMAKMICS_S120

Align I Cancel

Result: The "Axis Configuration - Axis_1 Drive Assignment" dialog box opens again.
8 Select your "actual drive unit (SINAMICS_S120)".
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3.10 10. Step: Configuring the axes with S7T Config

Sequence Activity | Result
9 The configured message frame is taken over from the drive configuration and must be confirmed in this
dialog box. Enter the maximum motor speed as "Rated speed” (see motor type plate). Set a maximum
motor speed of 6000 rpm for our example. Confirm your settings with "Continue".
Axis configuration - Axis_1 - Drive assignment ﬂ
YWhich drive unit are vou using’y Dirive:
SINAMICS_5120 x| |sERvo_nz x|
Log. HW addrezses: Input: |25E Cutpuk; IEEE
CJEncoder azsignment Align Sinamics devices... |
[JCempletion Wwhich meszage frame tppe do you want to uze for data transfer?
I Meszzage frame 105 j
¥ Dynamic servo contral [DSC)
t axirum zpeed: TR
r Mo longer display
information for real axes
“i'ou can establizkh the connection o a dive on thiz page. For a drive =
¢ Back I Continue > I Help |
Result: A message box appears.
9 Close the message box with "OK". The "S7T Config Help" online help opens.
10 Close the online help. The "Axis configuration - Axis_1 — Encoder
assignment” dialog box opens.
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3.10 10. Step: Configuring the axes with S7T Config

Sequence Activity Result
11 Select the encoder type and mode, and the measuring system. Settings for the first axis in our example:
e "Encoder type" is an "Absolute encoder”
e "Encoder mode" is "Endat"
e "Measuring system" is "Rotary encoder system"
Confirm with "Continue".
Axis configuration - Axis_1 - Encoder assignment El
[w]dmiz type -
[w] LI it
[w]fA Lo
[W|Cirive azsignmert Where is the position encoder conneched?
I:q;l [SINAMICS_5120 - Encoder SMI20_7 of SERVO_02 =l
4 I I 3
Log Hw addreszes: [put; IEEE Clutput: |25E
YWhich meszage frame type do you want to uze for data transfer?
IMessage frame 105 j
Encoder t_I,IDEZ A hzaolute encoder
Encoder mode: IEnu:Iat j
Meazuring system; IHDtar_I,I encoder system j
“'ou can zet the encoder used far thiz axiz on thiz page. ou can ;I
alzo select zpecial connection types of the encoder. _I
< Back I Continue > I Help |
Result: The "Axis Configuration - Axis_1 - Encoder - Data" dialog box opens.
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3.10 10. Step: Configuring the axes with S7T Config

Sequence Activity | Result
12 Enter the resolution specified on your motor rating plate as well as the number of data bits. In our example,
the number of encoder pulses is "512" and the number of data bits is "21".
Axris configuration - Axis_1 - Encoder - data x|
[w] LI itz ;I Encoder pulses per revolution: |5‘| 2
M'?"j'-‘l':' _ Multiplication factar of the cyclic 0
[w] O rive azzignment actual value [Gn_=I5T1]: I
[w]E nooder azsignmer: kultiplication factar of the abzolute 0
- actual value [Gr_+IST2): I
Murmber of data bits:
E ncoder monitoning active: [
Enter the special data of the zelected encoder on thiz page. ﬂ
I
¢ Back I Continue » I Help |
Accept the settings with "Continue".
If you use another encoder type, you can find appropriate examples for the encoder configuration in the
online help of S7T Config.
Result: The "Axis Configuration - Axis_1 - Completion" dialog box opens, showing the data you configured.
13 Complete the axis configuration with "Finish". A message box appears.
Axis configuration - Axis_1 - Completion x|
Al the necessary data for configuration has been entered
Configuration of this axis: -
[0 rive aszignment 3ME:
W]E ncoder azsignment Tég:“:oi\; X
WIE ncoder - data - Pnsitio%y;axis
iz type;
- Linear axis
DV_NQ modulo selected
r—“ﬁéma of drive: "SINAMICS_S120"
- Output;
+ Drive on PROFIBUS,
: Ed:siz.;‘gi\l’?rangdtgz:e;DPjEL1 05_E11U_DSC_1_ENCODER™
i =]
< Back Help |
14 Close the message box with "OK". The "S7T Config Help" online help opens.
15 Close the online help. The axis configuration with S7T Config is
completed.
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3.10 10. Step: Configuring the axes with S7T Config

Sequence Activity Result

16 Select Project > Save and recompile all to save the The system now compiles the axis
configuration in S7T Config. configuration data.
Note:

Repeat sequence 1 to 16 in step number 10 if you are using a double axis module.

The SINAMICS® demonstration case has a motor module with absolute encoder and a motor module with
incremental encoder. Make sure that you make the correct settings during the configuration of the second
axis.

The second drive has an incremental encoder with 2048 encoder lines.

Axis configuration - Axis_Z7 - Encoder assignment El

[w]dmiz type -
[w] LI it

[w]fA Lo

[W]Dirive azzignmett

Where iz the pogition encoder connected?

20 - Encoder Motor_E of SERWO_03

5

Log Hw addreszes: [put; IE?E Output:; 276
YWhich meszage frame type do you want to uze for data transfer?

IMessage frame 105
Encoder type: IIncrementaI encoder

Encoder mode: I Rectangular TTL

Measuring spstem: IHDtar_I,I encoder spstem

“'ou can zet the encoder used far thiz axiz on thiz page. ou can ;I
alzo select zpecial connection types of the encoder.

< Back I Continue » I Help |
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3.10 10. Step: Configuring the axes with S7T Config

Sequence Activity | Result

Axis configuration - Axis_2 - Inc. encoder data x|

Uitz - Encoder pulzes per revalution:
Mgdulu:u ) b ultiplication factor of the cyclic
A Drive assignment act. val [Gn_XISTT):
Encoder azsighmer:

Enter the zpecial data of the zelected encader oh this page. ;I

¢ Back I Continue » I Help |
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3.11 11. Step:

3.1 1

Creating the technology DBs

1. Step: Creating the technology DBs

Procedure
Sequence Activity Result
1 Change to "Technological Objects Management". Confirm the first message box with "OK", and the second
with "Yes".
If you are not running the "Technological Objects Management* application yet, you can open it by double-
clicking "Technological Objects” in the "Technology* folder in SIMATIC Manager (see also step:
"Configuring the axes with S7T Config").
Result: The "Technological Objects Management" opens.
BN Technology Objects Management {TOM) - [S7 Program(1} (Technology', Technolog -0 x|
ﬂ Technology objects  Edit  View Options ‘Window Help - |E|5|
IEH 2B E e
Technology DE updating time: 15,000 ms
Technology data blocks in the block Falder (block list) ¥  Delete |
DE | Symbol I Technology object I Comment I
Technology DEs not yet created (Defaulks list) 4+ Create |
DE Symbal | Technology object | Comment
Positioning axis
@ DBz Trace Trace 57 daka Far Trace of the MC subsystem
& DE3 MC d... MC device Stakus of the MC subsystem
o DB4 fxis_2 | ik Axis_2 Positioning axis
4] | I
Tvpe: Positioning axis IW S
Edit the DB numbers as shown in the figure in order to adapt these for use in our example.
2 Create the technology DBs listed below by clicking "Create™: | The system generates the technology data
e Axis_1 blocks DB1, DB2, DB3 or DB4.
e Axis_2 (if this exists)
e Trace
e MCDevice
3 Close the "Technological Objects Management" via the
Technological objects > Exit menu command.
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3.12

Procedure

3.12 12. Step: Controlling the axis with the STEP 7 user program

12. Step: Controlling the axis with the STEP 7 user program

Sequence

Activity

Result

1

In SIMATIC Manager, open the sample project
"\Examples\PROJECT-CPU317T". Copy the blocks listed
below to your project:

o OB1

e FB 100 (SimplePositioning)

e FB401 (MC_Power)

e FB402 (MC_Power)

e FB405 (MC_Halt)

e FB410 (MC_MoveAbsolute)

o DB 100 (IDB_SimplePositioning)

o AxisData (variable table for axis control)

_~ o~~~

Confirm the message "The object 'OB1' already exists. Do
you want to overwrite it?” with "Yes".

Also copy the inputs, outputs and flags from the example
symbol table to the project, so that the symbols are
displayed completely in the variable table.

Important: The sample program does not contain DB1 to
DB4! Create these technology DBs in STEP 7 (see the step
"Creating the technology DBs"), in order to maintain
consistency between the user program and the technology
objects.

The sample program is copied to the project.

You can edit the sample program in the LAD/STL/FBD
Editor. To do so, click FB 100, then right-click to select
"Open object".

The LAD/STL/FBD editor opens.

Select these settings:

e View > LAD,

e View > Overviews, and
e View > Details.

You have now opened an extended and
clear view for editing the STEP 7 user
program.

In SIMATIC Manager, load the entire user program to the
CPU with PLC > Download user program to memory
card.

Confirm the message box with "Yes".

The STEP 7 user program is now stored in
the CPU. This download of your SDBs may
take longer (up to a few minutes), because
of their larger data volume.
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3.13 13. Step: Trial run

3.13 13. Step: Trial run

Procedure
Sequence Activity Result
1 In the "Blocks" folder of your project, double-click the The variable table is opened for monitoring.
"AxisData" variable table.
2 Select PLC > Connect to > Configured CPU to go online. The CPU "STOP" status is indicated on the
bottom right.
3 Select Variable > Monitor to set monitoring mode. The "Status value" column shows the actual
values of the addresses.
Use the variable table to monitor the control
and status bits of the application, and the
status of the axis.
Caution

You start the drive in the next two steps.
To stop the drive again:

Set input 10.2 (Stop) to "1"

Switch the CPU to STOP.

4 Switch the CPU to RUN. The CPU "RUN" status is indicated on the
bottom right.

5 Perform the following trials: Monitor the relevant output values.

o Enable the axis by setting 10.0 ="1" (DriveEnable)

e Move the axis into position 2 (500 mm) by setting 10.4 (StartPosition2)
e Move the axis into position 1 (0 mm) by setting 10.3 (StartPosition1)

e Stop the moving axis with a signal at 10.2 (Stop)

e Acknowledge all queued errors of the axis with 10.1 (Reset)

Terminal strip:

. Drive Enable Velocity:
. Reset
Axis 1: v =100 mm/s
. Stop
@ start_Positiont
. Start_Position2
Position1 Position2
0 mm 500 mm

< o
@il )

Axis 1 -
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4.1 Further information

Diagnostics / correction of errors
Incorrect operator input, faulty wiring or inconsistent configuration data may lead to errors.

For information on how to analyze such errors and messages, refer to the S7-7echnology
manual.

Service and support on the Internet

In addition to our documentation, we offer a comprehensive online knowledge base on the
Internet at:

http://www.siemens.com/automation/service&support

There you will find:

The newsletter that provides you with latest information relating to your product
Your appropriate documentation, using our Service & Support search engine
A bulletin board in which users and specialists worldwide exchange their know-how

Your local Siemens partner for Automation & Drives in our Partner database

Information about local service, repairs, and spare parts. You will find much more under

"Services".
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Further information

4.1 4.1 Further information
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